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To get started, follow the instructions

on the next page to install Mac OS X.

Then let this book help you discover

how easy Mac OS X is to use.
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Before you start

While you can install Mac OS X on your computer by itself, if you want to continue using your 
Mac OS 9 applications with Mac OS X you must have Mac OS 9 installed on your computer. If you
don’t have Mac OS 9 installed on your computer, you should do so before you install Mac OS X.

There are two ways you can install Mac OS X to continue using Mac OS 9:

m You can install Mac OS X on the same disk you have Mac OS 9 installed on. Doing so does not
change Mac OS 9 or the other contents on your disk (except to move them to a special folder on
your computer).

m You can install Mac OS X on a separate disk or disk partition, keeping Mac OS 9 on its own disk
or disk partition.

Important  If you use separate disk partitions, be sure Mac OS 9 is installed on the first partition.

To set up Mac OS X after installation finishes, you need information about your network settings. If
you don’t know this information, ask your system administrator or Internet service provider.

Installing Mac OS X software

To install Mac OS X:

1 Insert the Mac OS X CD and double-click the Install Mac OS X icon.

2 Click Continue. The Installer restarts your computer.

3 When the Installer appears again, follow the onscreen instructions.

When the installation is finished, your computer restarts.
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Installing
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Setting up

After you finish installing Mac OS X, the Setup Assistant appears. The Setup Assistant guides you
through setting up important features of Mac OS X, such as network and Internet settings, email,
and the first user account for your computer. Follow the instructions in each panel. When you
finish, restart your computer.

Important  Be sure to remember the user name and password you enter because you need it to
log in to your computer.

Logging in

When your computer starts up, you log in using the user name and password you created with the
Setup Assistant.

The user you create with the Setup Assistant has privileges to administer your computer. When you
log in you can access all the folders on your computer, change system settings, install new
applications, and create other users.
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To learn more, search Mac Help for:

How do I use Help?

Getting more information

Throughout this book, you’ll see questions like
the one below to ask Mac Help. To get answers,
choose Mac Help from the Help menu, type the
question, and click Ask.

Why do I need to log in?

Logging in makes your computer more secure
because it determines your access privileges to
the computer. You can create other users to let
other people use your computer, but control
their access privileges.

Type the
question
here, then
click Ask.

Type your user name
and password here,
then click Login.
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When Mac OS X starts up, you see the Desktop application with a Finder

window and the Dock—a new way to organize the applications and

documents you use frequently.

4

This menu includes the commands
for setting application preferences
and quitting.

Use the Finder window to access and
organize your documents and applications. 
At first, it shows your “home” folder—
your private space on your computer.

Click an
icon in the
Dock to
open an
application.

Click here
to change
the view of
the Finder
window.

The
Desktop
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Finder views

You can view Finder windows in three ways. Click the View button to change the view.

The application menu

All Mac OS X applications have an application menu, which contains important commands such as
setting application preferences and quitting the application.
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To learn more, search Mac Help for:

How do I use the Desktop?

What’s a “home” folder?

Each user on your computer has a “home”
folder—a private space on the computer for
documents. Users can control access to their
home folders so that other people using the
computer can’t open their documents.

Where are my Mac OS 9 applications
and documents?

To see your Mac OS 9 applications and
documents, click the Computer button in the
Finder window, then open the Mac OS 9 folder.
This folder also contains your Mac OS 9
documents.

Open a window for a folder

To open a separate window for a folder, press
the Option key while you double-click the
folder’s icon.

In list or icon view 
double-click a folder 
to see its contents 
in the Finder window.

The application’s name

Choose this to set the
application’s preferences.

Choose this to quit the
application.

Column view shows the
path to the selection on
your disk or the network.
Try column view to see
how your disk is organized.
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A Finder window is your gateway to your computer and network. 

In a Finder window you see icons for your documents, folders, 

disks, and servers.

6

Click a toolbar button to
see your disks, open
your home folder, or
open other folders.

Shows
information
about the
selected
item. If it’s
a picture,
you see 
a preview. 
If it’s a
movie, you
can play it.

Click this button
to see your disks
and servers.

Shows 
the folders
(path) that
contain the
selected
item

Finder 
windows
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Toolbar buttons

The toolbar buttons at the top of a Finder window open special folders on your hard disk. Here’s
what you see when you click each button:

Computer

Your disks, CDs, and servers

Home

Your home folder—your private space on the computer

Apps

The Applications folder in your home folder.

Docs

The Documents folder in your home folder ( You see this folder when you save or
open a document in an application.)

Favorites

The Favorites folder in your home folder ( You see items in this folder when you save
or open a document.)

People

The Users folder on your hard disk where user home folders are located

7

To learn more, search Mac Help for:

How do I use the 
Finder window?

Move, copy, or make an alias to a file

To move a file to another folder, drag it. To copy
the file, press the Option key while you drag. To
make an alias to it, press the Command and
Option keys while you drag.

Open another Finder window

If you need to open another Finder window to
move or copy a file, choose New Finder Window
from the File menu.

To set access privileges to a folder

Select the folder and choose Show Inspector
from the File menu, then choose Sharing from
the Show pop-up menu.

Change the Desktop picture

Choose Preferences from the Desktop menu and
click the Desktop tab.

Can’t find it?

Click the Sherlock icon in the Dock, then click
Files in the Sherlock window. Type what you’re
looking for, then click the magnifying glass.
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The Dock makes it easy to open applications and to see which

applications and documents are open. To open an application 

in the Dock or make an application or document active, click its icon.

8

Trash

Drag files here to throw
them away. Drag disks

here to eject them.

Mail

Send and receive email.

Desktop

See your disks,
folders, and
documents any time.

The 
Dock
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Adding icons to the Dock

The Dock includes several applications that come with Mac OS X. You can add icons to the Dock
for applications, documents, folders, servers, Web sites, and QuickTime TV channels. To add an
icon, drag it to the Dock. Application icons go on the left; all other icons go on the right.

Putting windows in the Dock

You can put windows in the Dock by clicking buttons in the window.
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To learn more, search Mac Help for:

How do I use the Dock?

See the names of items in the Dock

Drag the pointer over the icons.

Rearrange the Dock

Drag icons to where you want them.

Remove an icon

Drag it out of the Dock.

Open a document using an application
in the Dock

Drag the document’s icon to the application’s
icon in the Dock.

Changing the Dock

To resize the tiles in the Dock, make them zoom
when you drag over them, hide the Dock,
choose Desktop & Dock Preferences from the
Desktop menu, and click the Desktop tab.

Click to put the 
window in the Dock.

Click to display only one
window at a time. Other

windows go in the Dock.

Click to display 
several windows.
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Use the Preferences application to change your computer settings. To

open Preferences, choose System Preferences from the Desktop menu.

Then click a button at the top.
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Click a button to show
the panel containing the
settings you want to
change.

If this icon is locked, click it;
then type the password for a
user with access privileges to
administer your computer.

Changing 
settings
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Important settings panels

These are some important settings panels in the Preferences application. To change some settings,
you need the password of a user with access privileges to administer your computer.

Classic

If you have more than one Mac OS 9 system available, select which one your Mac OS 9
applications use.

International

Change the language your computer uses and the way dates, time, and numbers are
displayed.

Login Items

Pick the applications or documents that open automatically when you log in.

Monitors

Change your monitor’s resolution and colors.

Network

Enter network and Internet settings.

Password

Change your login password.

System Disk

Select a startup disk for your computer. You can select a disk with Mac OS 9 or Mac OS X.

11

To learn more, search Mac Help for:

How do I change computer
settings?

Set application preferences

The Preferences application is where you set
system preferences. Applications also have
preferences. To set preferences for a Mac OS X
application, make the application active and
choose Preferences from its application menu.

Preferences for Mac OS 9 applications remain
where they were, usually in the Edit menu.

Return to Mac OS X from Mac OS 9

You can use the System Disk panel to select 
a Mac OS 9 startup disk. When you restart, 
your computer starts up using Mac OS 9. To 
start up using Mac OS X again, use the Mac OS 9 
System Disk control panel, which is on the 
Mac OS X CD.
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Use the Mail application included with Mac OS X to send and 

receive email. Your email can include pictures, sounds, and movies 

as well as text.
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Each email account has one mailbox. You can
create more mailboxes (folders) to organize your
email. Drag an email to a mailbox in this window.

Click here
to get your
mail.

Click here 
to see your
mailboxes
(folders for
storing mail
you receive).

Click here to write 
a new email message.

Using 
Mail

 MX0403.OSXInstall_color  4/25/2000 1:46 PM  Page 12



Sending email

To send an email message, click the Compose button, type the address, and prepare your message.
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To learn more, search Mac Help for:

How do I send and receive
email?

Setting up

When you set up Mac OS X using the Setup
Assistant, you also set up how to send and
receive your email. To change settings or create
other mail accounts, choose Preferences from
the Mail menu.

Change the active account

Mail lets you receive email from more than one
email account. To make an email account active,
click the Active column next to the account’s
name in the Accounts preferences panel. To see
your messages, select the account’s mailbox in
the Mailboxes window.

Organize addresses

Use the AddressBook application to store email
addresses and add them to your email quickly.

Use Mail services

To send pictures, sounds, or movies in an email
message directly from the application where 
you create them, choose Services from the
application menu, choose Mail, then choose 
Mail To. 

As you type an address,
Mail selects matching
addresses from your
address book. When you
find the one you want, 
press the Tab key.

To add a picture, sound, 
or movie to your message,
drag it from the Finder to
your message. (You can
also use Mail services to add
these to your message.)
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Mac OS X applications have new ways to save and open documents

that make it faster and easier.
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Saving and 
opening

Click here to show other folders
or switch to another disk.

Choose
folders
here using
the column
view.

Choose a recent or
favorite folder here.

The panel is
attached to the

document.
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To learn more, search Mac Help for:

How do I save a document?

Opening documents

When you choose Open in a Mac OS X application, you see a new panel for locating your
documents.

Save a document in your home folder

When you save a document the first time, the
panel shows your home folder. Type a name and
click Save.

Add a folder to your favorites

Select the folder, then click Add to Favorites.
Mac OS X puts an alias of it in the Favorites
folder in your home folder.

Choose a recent 
or favorite folder here.

You can type the path 
to a document here.

A column view similar 
to the Finder window.
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Mac OS X provides a new way to print your documents. First use

PrintCenter to select printers and set them up. Then print your work.

16

Choose how to connect
to the printer here.

Select a printer you want to
add to the PrintCenter here.

Printing
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Setting up

Before you can print a document, you need to select a printer using the PrintCenter. If you haven’t
selected a printer when you print the first time, the PrintCenter opens. Using the Print Browser
panel, select how to connect to the printer and double-click the printer you want to add.

Printing a document

To print a document, choose Print from the File menu. The Print panel opens with the default
printer selected.

Previewing a document

When you print a document, you can click Preview to open the Preview application and see how it
will look.
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To learn more, search Mac Help for:

How do I print my documents?

Select a default printer

The default printer is the printer selected in the
Print panel when it opens. If you don’t select a
default printer, the PrintCenter picks one for
you. To select or change the default printer,
select the printer in the PrintCenter window 
and choose Make Default Printer from the
Printers menu.

Change the destination printer

When you print a document, the default printer
is the destination. To select a different printer,
choose one from the Destination pop-up menu.

Click here to preview
the document.

Default printer

Click here for
more options.

Choose a different
printer here.
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Applications

Mac OS X includes several applications designed for Mac OS X. 

You can also continue to use your Mac OS 9 applications.

AddressBook

Keep all your email addresses and other information about people in one place.

Sherlock

Find what you’re looking for on your disks or network, or on the Internet.

QuickTime Player

Play movies, view pictures, listen to music, watch QuickTime TV.

Preview

Preview documents.

Multiple Users

Give other people access to your computer.

TextEdit

Create text documents with text styles.

Grab

Take pictures of your desktop or a window.

18
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Where to find the applications

The Applications folder on your hard disk: The location where Mac OS X applications are installed
so that all the users of your computer can access them. You need to log in as a user with access
privileges to administer your computer to install applications in this folder.

The Mac OS 9 folder: Contains the Mac OS 9 applications installed on your computer before you
installed Mac OS X.

Using Mac OS 9 applications

After you install Mac OS X, your Mac OS 9 applications work the same way they always did. To open
a Mac OS 9 application or document, just double-click its icon.

When you open a Mac OS 9 application, the Mac OS 9 system needs to start up. To have the 
Mac OS 9 system start up when you log in, click the Preferences icon in the Dock, then click Classic
and select the “Start up on login” checkbox. 
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To learn more, search Mac Help for:

How do I use my applications?

Copy and paste between documents

Select what you want to copy and drag it to the
other document. You can copy between
documents in different applications.

Use application services

Mac OS X applications may provide services that
you can use with other applications. For
example, Mail lets you select a picture in an
application and send it in an email message. To
see the available services, select something in an
application and choose Services from the
application menu.

Update your software

Mac OS X includes the Software Updates
application so that you can get the latest version
of your Mac OS X applications and system
software.
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Troubleshooting

You see a message about updating the firmware.

If you see a message that you need to update your computer’s firmware, you should do so before
proceeding with the installation. The updater and instructions are available at the Apple Software
Updates Web site (http://asu.info.apple.com/).

The Installer cannot repair your hard disk.

The Installer repairs your hard disk before it installs Mac OS X. If you see a message that the disk
can’t be fixed, try these solutions: 

m If a file is open, quit all programs. If file sharing is on, turn it off. Then try installing again.

m If you still get the message, use DiskFirstAid (provided on the Mac OS X CD), to repair the disk.

m If you can’t repair the disk using DiskFirstAid, you may need to reinitialize it. Back up your hard
disk before you erase all the files on it. Then use the Drive Setup program (provided on the 
Mac OS X CD), to initialize the disk. After you initialize the disk, use the Mac OS X Installer to
install the software again, then reinstall your application programs and documents from your
backup copy.

The Installer cannot update the hard disk driver.

The Installer cannot update non-Apple hard disks. Use the disk utility recommended by the
manufacturer of your hard disk to update your drivers before installing Mac OS X. Make sure to use
a version of the utility that is compatible with Mac OS X.

Installing Mac OS X was interrupted and now I can’t restart my computer.

If this happens and you have Mac OS 9 installed on your computer, try restarting your computer
while pressing the Option key to start up using Mac OS 9.

If you cannot start up using Mac OS 9, insert a Mac OS 9 CD in your computer and press the C key
while restarting your computer.

20
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You can’t log in to your computer.

First, make sure you are entering your password with the same capitalization and punctuation that
you used originally. If you still can’t log in, log in as a user with administrator privileges and change
the password for your user account using the MultipleUsers application.

Network services don’t seem to be working.

If your network services don’t seem to be working properly, try these solutions:

m Make sure that your computer is connected to the network properly.

m Use DiskFirstAid to make sure your hard disk is working properly. 

m Check your computer’s AppleTalk and TCP/IP configurations. 

m See if you can access AppleTalk devices on the network.

m See your server administrator to make sure the server you are trying to connect to is available.

You can’t quit an application.

If you can’t quit an application, you can force it to quit. Press the Command, Option, and Escape
keys, select the program in the Applications panel, and click Force Quit. (You do not need to
restart your computer.)

Important  When you force an application to quit, any unsaved changes to documents open in
the application are lost.

21
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